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ODbjectives

* Access Global Precipitation Measurement (GPM) Integrated Multi-satellite
Retrievals for GPM (IMERG) precipitation data through Giovanni

« Analyze precipitation, soil moisture, terrain, and Socioeconomic Data and
Applications Center (SEDAC) data for the Kerala flood using QGIS to identify low-
lying areas with high flood potential and impacts
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Reqguirements

 QGIS installed on your computer
— https://arset.gsfc.nasa.gov/sites/default/files/users/QGIS-instructions.pdf

* A shapefile and associated raster files provided by trainers of Kerala saved on your
computer
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Note

e This Is a two-part exercise:

— Part 1 will focus on access and analysis of GPM IMERG precipitation data using
Giovanni

— Part 2 will use the GPM IMERG and Soil Moisture Active Passive (SMAP) data over
Kerala, along with SRTM terrain and SEDAC population and Landsat-based
urban/rural surface data for analysis

o After the completion of this exercise you will break into groups of 5

 Based on the results of this exercise the groups will put together a 5-7 minute
presentation that each group will present in the last session of the day
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Part 1: Outline

« Examine precipitation during August 2018 in Kerala

« Subset and make time series of GPM IMERG precipitation data using Giovanni

— Giovanni is an online environment created by NASA for the display and analysis
of geophysical parameters to access data

— With Giovanni, you can find and display data in different types of plots
— Giovanni also allows you to download the plot source files in NetCDF format
(along with other formats)

 Examine and download a map of GPM IMERG precipitation using Giovanni
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Part 1. Giovanni for GPM-IMERG Data Access and Analysis

1. Go to Giovanni: http://giovanni.gsfc.nasa.qgov/giovanni

2. On the Giovanni page you will see the following options:
— Select Plot: allows selection of analysis options
— Select Data Range (UTC): allows selection of a time period

— Select Region (Bounding Box or Shape): allows selection of a geographic
region by latitude-longitude, map, or shapefile

— Keyword: allows search of data parameters by keyword

— Plot Data: (located on the bottom right of the page) begins the action to
make a desired plot
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Part 1: Subset GPM IMERG Rainfall and Plot Time Series

3. Enter the following options:
— Next to Keyword
* Enter IMERG Late. Click Search

» Select Daily accumulated precipitation (combined microwave-IR)
estimate - Late Run (GPM_3IMERGDL_vO05)

= EARTHDATA Data Discovery DAACs Community Science Disciplines

G’O VANN’ The Bridge Between Data and Science v 4.28 Feedback Help
YYYY-MM-DD HH:mm Format: West, South, East, North
- B8 to L e x
Valid Range: 2014-03-12 to 2018-10-30

Please specify a start date.
Select Variables

¥ Disciplines I Number of matching Variables: 3 of 1932 Total Variable(s) included in Plot: 1

_| Hydralogy (3) Keyword : IMERG Late Search Clear
¥ Moasummenis Variable Units Source Temp.Res. Spat.Res. Begin Date End Date
| Precipitation (3)
=1 ulated precipitation (combined Crow: R) estimate - Late
> Platorm nsirumen . Fun_(GPM_SIMERGDL vi5) nﬂ“nm e
» Spatial Resolutions Multi-satellite precipitation estimate with climatological gauge calibration - Late Half- o
P Run  (GPM 3IMERGHHL v05) mmie [ | cPM Hourly 2014-03-12  2018-10-31
P Temporal Resolutions — | Random Error for multi-satellite precipitation with climatological gauge Half- B
» Portal calibration - Late Run  (GPM_3IMERGHHL v05) mm/hr GPM Hourly 04 20140312 | 2018-10-31
'orta
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Part 1: Subset GPM IMERG Precipitation and Plot Time Series

eeeeeeeeee

— Under Select Plot select Time Series: Area-
Averaged [y T
— Under Select Region (Bounding Box or
Shape)
* Enter the longitude-latitude around
Kerala: 74.0,8.0,78.0,14.0

 Note: east longitudes and north latitudes
are positive. West longitudes and south
latitudes are negative.

T0"00'E

[10

BO°DOE 8000

* Click on the map icon to see the region
— Under Select Date Range (UTC)

e In the YYYY-MM-DD windows, enter
2018-08-1 for the start date and 2018-08-
31 for the end date
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Part 1: Plot Time Series and Download

Time Series, Area-Averaged of Daily accumulated precipitation (combined

—_ CIle On Plot Data (On the bottom microwave-IR) estimate - Late Run daily 0.1 deg. [GPM GPM_3IMERGDL v05]

mm over 2018-08-01 - 2018-08-31, Region 74E, 8N, 78E, 14N

right)

— You will get the time series of dally .
accumulated rainfall for August 2018,
averaged over the selected domain ;

— Click on Download (on the left menu ¢S RO U
bar) to save the time series image 1Al GAg I1AG AW 21Am oAl I1A

- The user-selected region was defined by 74E, 8N, 78E, 14N. The data grid also limits the analyzable region to the following bounding points: 74.05E, 8.05N,
ion result.

an d also th e CSV fl | e O n yo u r 77.95E, 13.95N. This analyzable region indicates the spatial limits of the subsetted granules that went into making this visualizat
computer Note: you will have to login to NASA

Earthdata to download the data

w
wv

ep

Browse History

1. Time Series, Area-Averaged

D Please login to Earthdata to download data

} o Downloads
o Lineage
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Part 1: Questions

1. Which day had the maximum precipitation? How much?

2. Which period of the month experienced daily precipitation > 15 mm?
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Part 1: Plot IMERG Rainfall Maps

Map, Accumulated of Daily accumulated

3. Click on Back to Data Selection (bottom right) o
— Under Select Plot, select Map: Accumulated
— Under Select Date Range (UTC) F

2018-08-14 to start and 2018-08-15 for the E 'k

end date
- Click on Plot Data (on the bottom right)
- You will get the map of accumulated rainfall

- Click on the Downloads link on the left, and you will see multiple file options.
Choose the NetCDF (.nc) file by clicking on the link to save the file to your
computer for later use in QGIS

pitatio mbined microwave estimate - Late Run dail
ver 2018-08-14 - 2018-08-15, Region 74E, 8N, 78E, 14N
5

e In the YYYY-MM-DD windows, enter .

@
g
£}
=
=)

I =
o
w
~
=
<

@ '
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Part 2: Outline

 Conduct precipitation, terrain, and SEDAC data analysis for the Kerala flood using
QGIS

 Load IMERG precipitation raster saved in Part-1 into QGIS

« Copy and load SRTM terrain and SEDAC data (population, impermeable surface) -
you have been given this data on a USB drive to copy on your computer

e Calculate slope using the SRTM data

 Analyze all the data sets to identify areas with high flood potential and impacted
population
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Note

 We will resample the precipitation data, which is at 0.1 degree (10 km) to 0.01
degree (1 km) resolution

« We will clip all the data to the state of Kerala using the shapefile
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Precipitation Analysis in QGIS

1. Open QGIS and start a new project. Save  If you do not have the OpenLayers

the project to a working folder as Kerala plugin:
2. Set the Project > Properties > CRS > - Select Plugins from the top menu,
WGS84. EPSG:4326 and choose Manage and Install
| ' Plugins

3. On the top menu bar, click on Web to

check if you have OpenLayers plugin * You will get a window with options for

Plugins
@ QCIS Project Edit View Layer Settings [QTF[FJ] Vector Raster Database Web SCP Processing Window Help ° Enter OpenLayerS |n the SearCh

) T € T window*

* Click on the OpenLayers plugin and
press Install plugin in the bottom right

75 Not installed

ARNPIMETS © Showsiso experimental plgins - * If you do not see the OpenlLayers

Note: Experimental plugins are generally unsuitable for production use, These plugins are in early stages of devel
‘incomplete’ or 'proof of concept’ tools. QGIS does not recommend i i i

S S S S plugin, click on Settings and check the
- box for Show also experimental plugins

Plugin repositories
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Precipitation Analysis in QGIS

3. From the top menu bar, click on Web, select OpenLayers plugin and select a
background map

4. This exercise uses the plugin OpenStreetMap

@ QGIS Project Edit View Layer Settings Plugins Vector Raster Database m SCP Processing Window Help @ ¢ [ AR ©

o0 @ MetaSearch > QGIS 2.18.2

. Ef—_li ! .f_’)'b'» SO RN ;} z;/ 2 ::ﬂPBﬂLa?empugin_ E OpenLayers Overview = 5 [1]

Terms of Service [ About ™ £y ‘5‘

ﬂ
T e l #2 OpenStreetMa »  OpenStreetMap '
I S L o] @ —
O =4 - B @ *3 Google Maps »  OpenCycleMap

L
ﬁkﬂ*IB[H&L&X SE O E.@W. ﬂé&f\.@ml = Bing Maps » | OCMLandscape Y
06 Browser Panal 3 MapQuest 5 OCM Public .Trail'lsport

\,/pq : [ OSM/Stamen > 05M Humanitarian Data Model

“ il X 2.0 [ Apple Maps 2
' % Home

ks Favourites
f > !

W > Aolumes

i pB2
'ﬂ' P MssaL
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Add IMERG NetCDF Data

5. In your QGIS map, click on the Add Raster .
function on the left

6. Navigate to your accumulated precipitation
(.nc) data file saved from Giovanni analysis
and click on Open to add

— A Coordinate Reference System Selector
box may pop up. Select WGS84, : N R
EPSG:4326 i e e T

— From the top Menu Bar, use the Zoom In B ey @ﬁ- @
tool to zoom in and out on the layer

Note: These NetCDF images have to be converted to GeoTlFF images for you to
perform raster calculations on the data
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Convert NetCDF Data to GeoTiff

7. Right-click (or control-click on Mac) on the IMERG (.nc) raster layer

8. From the drop-down menu, select Export - Save As
— Note that the Format in the opened window is GeoTIFF
— Make sure the Add save file to map option is checked
— Click on File name and enter the folder name where all the data are and enter
a file name (Suggestion: Kerala-Rain) and click OK
— You will see the GeoTIFF layer displayed on the map and the file will be saved
to the data folder

9. Now you can remove the NetCDF raster layers by right-clicking on each
layer and choosing Remove Layer
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Add Kerala State Shapefile

10. Click on the menu on the left bar and click

Add Vector to add the Kerala shapefile (state.shp). -~
Click Add

11. To make the shapefile transparent with only the
border outlined, right click on the layer file and go
to Properties - Symbology

12. Click on the down arrow In the Fill window and select Simple line

13. Click on the down arrow in the Outline window and choose a color of the
shapefile boundary (This example uses black)

14. Set the Stroke width to be 1.5 Millimeter
15. Click OK to get the following result in the QGIS window
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Resample IMERG Rainfall Data

16. In the top menu, select Processing - Toolbox. A search window will appear to
the right of the map. Type “warp”

— You should see Warp (reproject) from the list
17. Double click on Warp (reproject) — this will open a new window
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Resample IMERG Rainfall Data

18. In the Input layer window use the dropdown menu to select Kerala-Rain

In the Source CRS dropdown menu select EPSG:4326 - WGS 84

In the Target CRS dropdown menu select EPSG:4326 - WGS 84

In the Resampling method, choose Bilinear

In the Output file resolution in target georeferenced units enter: 0.01

In the Georeferenced extents of output file to be created
(xmin,xmax,ymin,ymax), choose Use layer extent

Click on Reprojected = Save to file = project folder > Kerala Rain_1km
Make sure to check the box Open output file after running algorithm
Click Run
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Resample IMERG Rainfall Data

Parameters | Log

— You will see a new layer in your Layers il

=" Kerala_Rain_1km [EPSG:4326] -
. - Source CRS [optional]
Panel: Reprojected :
Target CRS

— Rename this layer (right click) > Rename T ‘

Laye r 9 Ke ral a_Rai n_l km Nodata value for output bands [optional]

Mot set

Output file resolution in target gecreferenced units [optional]
0.010000

¥ Advanced parameters

Additional creation options [opticnal]

[Note: we are not creating any new .
iInformation — just interpolating precipitation at
a higher resolution for spatial analysis]

Output data type
Use input layer data type =
Georeferenced extents of output file to be created (xmin, xmax, ymin, ymax) [optional]
74.00000313,78.00000313,8.00000173,14.00000173 [EPSG:4328]
CRS of the target raster extent [optional]
Project CRS: EPSG:4326 - WGS 84 =
Use multithreaded warping implementation
Reprojected
[Usersfsmccart4/Desktop/ARSET_3.4/Kerala_Rain_tkm.tif

+ Open output file after running algorithm
GDAL/OGR console call

gdalwarp -s_srs EPSG:4326 -t_srs EPSG:4326 -tr 0.01 0.01 -r bilinear -te 74.00000313 8.00000173 78.00000313 14.00000173 -te_srs
EPSG:4326 -of GTiff [Usersfsmccartd/Desktopf/ARSET_3.4/Kerala_Rain_1km.tif /Users/smccartd/Desktop/ARSET_3.4 /Kerala_Rain_1km.tif

0% Cance

Help Run as Batch Process... Close Run
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Clip IMERG Rain Data to the Kerala Shapefile

19. Now clip the interpolated rain layers to the Kerala
state shapefile

— On the top bar go to Raster - Extraction - Clip
Raster by Mask Layer

— In the Input File (raster) window select
Kerala_Rain_1km

— In the Mask Layer window select the shapefile
state

— Check the boxes for Match the extent of the
clipped raster to the extent of the mask layer
and Keep resolution of output raster
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Parameters Log |
Input layer
=" Kerala_Rain_1km [EPSG:4326] ) =
Mask layer
state [EPSG:4326] | -] @
Selected features only
Assign a specified nodata value to output bands [optional]
Not set
Create an output alpha band
v Match the extent of the clipped raster to the extent of the mask layer
v Keep resolution of output raster
¥ Advanced parameters
Additional creation options [optional]

Profile | Default

Mame Value

o | = Validate Help
QOutput data type
Use input layer data type

Clipped (mask)
{Users/smccart4/Desktop/ARSET_3.4/Kerala_ClippedRain_1km.tif
v Open output file after running algorithm

GDAL/OGR console call

gdalwarp -of GTiff -tr 0.01 -0.01 -tap -cutline /Users/smccartd4/Desktop/ =
ARSET_3.4/Kerala/state.shp -crop_to_cutline /Users/smccart4/Desktop/
ARSFT 3 A/Kerala Rain 1km tif /l Isers/smeocartd/Deskton/ARSFT 3 4/
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Clip IMERG Rain Data to the Kerala Shapefile

— Enter Clipped (mask) = Save to file Shiaoge

P adapapalp

- Working folder - _

Chikkamagaluru

Kerala_CIipped Raln_l km M;-n%ah_ rL B-El-lfll:élll.-l'u ufelllllmf-_' i

A mbur Kanchipuram

|'..'.';|Il‘

- CIiCk OK On a.t the bOttom right. Tiruwarnamalal
Now right-click and remove .
Kerala_Rain_1km from the layers |
panel e

ity
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Add Color to the Clipped Rain Layer

20. Right click on the clipped file Precipitation
Kerala_ClippedRain_1km and go to Properties - —
Symbology m:- / wsuel V% B Ve FAXOBEO 1 ~ . AT
— Select the Render Type as Singleband : N
Pseudocolor |
— In Color ramp, make sure the Red-Yellow-Blue %0
(RAYIBu) color palette is selected o e
— Right-click on color ramp and click Invert color
ramp so that low runoff values are shown in
blue and high in red

— Keep the default Min and Max values

— Below the color display, change the Mode to
Equal Interval and Classes to 10. Click Classify

— Click Apply then OK
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Make the Rain Layer Partially Transparent

Mangaluru
Bengaluru

Hosur

21. Right click on the clipped file
Kerala_ClippedRain_1km and go to Properties -
Transparency

22. Make the Global Opacity to ~50%

23. Click Apply and OK and you will get the rain layer
that is partially transparent and you will see the map
on the right

¥ Global Opacity

50.0 %
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Add SMAP Soil Moisture Data

24. Right-click anywhere in the tool bar and add the Browser Panel
25. Using the Browser Panel, select all 16 SMAP_L3 SM P E xxxxxxxx_Clip.tif files you

copied to your computer and add them to the canvas

— Using the steps 22-23, add RdYIBu colors to the first layer and also make it 50%
transparent. Invert the color ramp so red symbolizes higher values

— Right-click on the first layer - Styles - Copy Style
— Select all other SMAP layers = right-click = Paste Style

« Where are the highest soil moisture values located?
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Add SMAP Soil Moisture Data

— At the top of the screen click on Plugins > Manage and Install Plugins - Install
Value Tool

— In the Layers Panel select all SMAP layers - right-click > Group Selected
— Right-click in the tool bar and open the Value Tool Panel

— In the Value Tool Panel, click on the Table tab and explore the values as you
move your cursor over the SMAP images

— Next, click on the Graph tab and enter 0 for Y min and 0.75 for Y max

— Move your cursor over the SMAP images again for a time series of the 16
Images
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Add SRTM Terrain Data

26. Click on the Add Raster icon & Terrain
27. Navigate to the file Kerala_ ClippedSRTM.tif that you T
copied to your computer Bk ety

HEL

28. Using steps 22-23, add colors to the SRTM terrain layer
and also make it 50% transparent

[Note: the color PRGn are used for the terrain layer]

Kara!

Th
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Derive Slope from the SRTM Digital Elevation Model

Using the SRTM elevation in QGIS, we can create a slope

Input layer

prOdUCt USIng the DEM (Terraln MOde|S) TOOl " Kerala_ClippedSRTM [EPSG:4326]

Band number

Band 1 (Gray)

29. In the top menu, select: Raster - Analysis = Slope

111120.000000

30. |n the dialog that appears’ ensur‘e the |nput file iS the Slope expressed as percent instead of degrees

Compute edges

Keral a_C l ppe dSRTM.tif file we j ust visualized ipooiiwomhionotoinniohontidihtinsihdite

Additional creation options [optional]

Profile Default

Name Value

B = Validate Help

Slope
JUsers{smccartd/Desktop/ARSET_3.4/slope.tif

v Open output file after running algorithm
GDAL/OGR console call

gdaldem slope [Users/smccartd/Desktop/ARSET_3.4/Kerala_ClippedSRTM.tif /
Users/smccartd/Desktop/ARSET_3.4/slope.tif -of GTiff -b 1 -5 111120.0

0%

Help Run as Batch Process... Close Run
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Derive Slope from the SRTM Digital Elevation Model

31. In the scale (ratio of vert. units to horiz) box, enter =i ==
111120.00 to convert the units to meters

32. Do not check the Slope expressed as percent box -
the slope will be in degree

33. Set the Output file to your working folder and name
ending in .tif (Suggestion: slope.tif)

34. Click OK
35. The resulting image displays the slope in degrees

36. Using steps 22-23, change the color and transparency of the slope layer (use
PrGn colors)

NASA’s Applied Remote Sensing Training Program



Add Population Density Data

BEAS @8 %l Vi ,FELXABEO I ~

37. Click on the Add Raster icon & e

38. Navigate to file Kerala_PopulationDensity.tif that
you copied to your computer

39. Using the steps 22-23 add colors to the population =
density layer and make the layers 50% transparent

Note: the color BrBG and 20 intervals are used for the —  i=5
population density layer

39. Examine each layer by turning other layers off
40. Also examine precipitation with slope, population density, and urban areas
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Add Impermeable Surface Data

41. Click on the Add Raster icon & P

42. Navigate to file Kerala_Urban.tif you copied on your
computer

43. Using the steps 22-23 add colors to the population
density layer and make the layers 50% transparent

Note: the color Blues and 10 intervals are used to
highlight the impermeable areas between 10 to 100%

44. Examine each layer by turning other layers off
45. Also examine precipitation with slope, population density, and urban areas
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Questions

1. Using the map, write down what the maximum accumulated rain was for August
14-15.

2. What is the terrain height range where the rainfall was maximum?
3. Which city received more rain: Kochi or Alapuza?

4. Examine the slope by zooming in and see where low slope areas are surrounded
by high slope ridges.

5. Based on the rainfall and impermeable surface layers, list at least two cities,
towns, or urban areas that received >250 mm rainfall.

6. What is the population density range in the areas you listed above in question 5?
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Discussion

1. Can the slope information, impermeable surface information, and rainfall help in
identifying regions where flooding/water logging may occur?

2. Based on the rainfall, slope, and population density, in which areas might the
most number of people have been affected by flooding? Can you confirm this
based on in situ reports from news or other sources?

NASA’s Applied Remote Sensing Training Program



	Data Access and Analysis: Precipitation, Terrain, Socioeconomic Data 
	Objectives
	Requirements
	Note
	Part 1: Outline
	Part 1: Giovanni for GPM-IMERG Data Access and Analysis
	Part 1: Subset GPM IMERG Rainfall and Plot Time Series 
	Part 1: Subset GPM IMERG Precipitation and Plot Time Series 
	Part 1: Plot Time Series and Download
	Part 1: Questions
	Part 1: Plot IMERG Rainfall Maps 
	Part 2: Outline
	Note
	Precipitation Analysis in QGIS
	Precipitation Analysis in QGIS
	Add IMERG NetCDF Data
	Convert NetCDF Data to GeoTiff
	Add Kerala State Shapefile
	Resample IMERG Rainfall Data
	Resample IMERG Rainfall Data
	Resample IMERG Rainfall Data
	Clip IMERG Rain Data to the Kerala Shapefile
	Clip IMERG Rain Data to the Kerala Shapefile
	Add Color to the Clipped Rain Layer
	Make the Rain Layer Partially Transparent
	Add SMAP Soil Moisture Data 
	Add SMAP Soil Moisture Data 
	Add SRTM Terrain Data
	Derive Slope from the SRTM Digital Elevation Model
	Derive Slope from the SRTM Digital Elevation Model
	Add Population Density Data
	Add Impermeable Surface Data
	Questions
	Discussion

